Parent T.I.P.S.

Finding internet-based
materials to support school
assignments

HIAT Team



This presentation will provide
[you with...

Links to Iinternet-based resources

Websites that support student projects
and reports

Instruction on how to use
Autosummarize in MS Word

Instruction on how to digitally create
note cards

How to more easily write citations




Students often struggle with
[ projects and reports

They struggle to:
Get organized
Select topics
Locate information
Read the information they find
Summarize information they have read
Cite sources
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Getting organized
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For upper grades:

Assignment calculator
http://www.lib.umn.edu/help/calculator/




US MS Word tables to create
[customized assignment forms

issignment Log: Period

Assignmuent Date Ched: if cooplabed or explaim why | Turmed
due incornplete i
Things Ineed to do this assignmuent:
Assisnmuent Date Ched: if complabed o explaim why | Turned
due indornplate i
Things Ineed to doe dhis assaznmuendt:
Assisnmuent Date Ched: if complabed o explaim why | Turned
due indornplate i
Things Ineed to doe dhis assaznmuendt:
Assirnmuent Dade Ched: if complabed or explam why | Tuoned
due miornplate I
Things Ineed to doe dhis assaznmuend:




Websites to help students select a

research topic or project
4 2 explore - For lower grades
http://42explore.com

Thinktank — for middle grades
http://thinktank.4teachers.orq

emints resources
http://www.emints.org/ethemes/index.shtml

Noodletools - for upper grades
http://www.noodletools.com/noodleguest




Locating information

Using educational search
engines



Finding e-text using search
engines to support the curriculum
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TekMom
http://www.tekmom.com/search/index.html

[ |




Finding e-text using search
engines to support the curriculum

Clusty



web news images wikipedia blogs jobs more »

inaugurations Search e

Top 245 results of at least 70,502 retrieved for the query inaugurations (definition) (details)

MU sources  sites

All Results (247) remix  Inauguration - Save on airfare to DC when you book for President Obama's inauguration | - wrw Chezpflights com/Tnauguration

@ University @46 . - , - .
EVErSTy 40) Illﬂllglll‘ﬂtlﬁlls at AMAzon - Millions of titles, new & used. Qualified orders over $23 ship free - Amazon com/books

© History (26)

© Photographs 23)
© USA Presidential (1) 1. "TDo Solemnly Swear...": Presidential Inaugurations & a &

[ Do Solernnly Swear .. " Presidential Inaugurations 15 a collection of approximately 400 ttems or 2,000 digital files relating to

inaugurations from George Washmgton's in 1789 ..
© Obama 13) memory loc gov/ammern/pthtml/pthome html - [cache] - Live, Gigablast, Ask

© Inaugural Address (18)

@ Government (16) o » - . -
2. Joint Congressional Committee on Inaugural Ceremonies & Q &

Plans and executes all Capitol activities for the 55th Inauguration of the President of the United States on Jarwary 20, 2003, includ

© Library, Congress(12) the swearing-in cerermony. Recetves requests ..
inaugural senate gov - [cache] - Live, Open Directory, Ask

O auguration Day (12)

@ Definition(10)

o | . et 3. Inauguration - Wikipedia. the free encvclopedia & a &

An inauguration 15 a ceremony of formal mvestibure whereby an individual assumes an office or posttion of authority or power. The

firid 11 rhustere



MCPS Parents
Tab

> Homework
Resources

Ask your school
media specialist
for user name

and passwords

www.montgomeryschoolsmd.org

» Montgomery County Public Schools

HOME ABOUTUS SCHOOLS

HSA PREP
ONLINE

Praclice Quastions

’ Learn Algebra
THE with
MATH DUDE!

y -4 TV ONLINE- IPOD

LINKS FOR STUDENTS

= Calendars

= hienmus
Iannis an erpatiol

= Emegency Clesings

= Condant Infomation

= School-odex

Schood Wi Sites

Svten of Shared
Accountahdlity

= School Survey Resubts

= Grem Sdhools Foous

= Extended Hours Program

WO

= Cumicuhum

= Course Bullein (3-12)

= Siudent Online
Leamming

* Studend Service
Leaming

= Standardired Tesls

* Student Life

* Studend Board hManha
= Sudent Govemnmuent
= Fiudendt Rights and

= Sdhweol Safely

= Afhlalic Events

= Theata Sdhedule

ROCKVILLE, MARYLAND

COMMUNITY BOARD OF EDUCATION

FOR PARENTS

FOR STUDENTS = HOMEWORK RESOURCES
Homeworlk Resources: Get help now!

MCPS Resources

Subscription Se

SEARCH

GO
INDEX OF TOPICS

FOR STAFF

Homwework Board

A ssizments
Homework Hotline
Call-in cable TV show

Internet Safety

Digital Vertical File

Chip art, photos, graph paper, more
Pictures from Communities
Avound the World

Ghana, Japan, Mexico

A1 services are availahls for home
use, sk wour school media
speciabist for user name and
pasqancrd,

All Schools/ATl Grades
Annalz of American History
Encyclopsdia Britanmica
Online School Edition
Culture Grams

Enciclopedia Universal en
Espaiiol

neilrekdeer

[Search Enzine]

MoodleTools

S5IRS Discoverer

S5IRS Enowledge Source
TeachingBooks.net (Literature
Resomree)

Wehster's New International
Dictionary

World Book Online

World Data Analysi
Elementary Schools
Computers Only

Fartz for Learning
Elementary and Middle
Schools Computers
MewsBank: KidsPage
Middle Schools Computers
Only

America's Historical
Mewspapers

Student Resource Center
Junior

Mhliddle and High Schools
Computers

Iszues & Coniroversias

Montgomery County
Puhlic Libraries
Eadsite | Temsite
Maryland

State Government
Sailor | Sailor Kids
Maryland's Online Public
Information Hebaork
U.5. Government
FirsiGov for Kids

List of government kids' sitas by
subject.

IMNewspapers
Baltimore Sun

Gazette Newspapers
Sentinel Newspapers
Washingion Fxaminer
Washingion Post
Washingion Times



aHome Page Back @Dictionary gThesaurus 2Help | Tips | Cite

Type in Key word(s) and click Search button below.

Sea I'Ch F{)[’Iinvasive species ianuIITextj
|AnD =] | infre =
I’&‘NDj I in Izﬂauthnr j

Use AND, OR, and NOT to refine your search. More fips.

Return articles by: ~Relevance ~ Date = Lexile o - Lexile v
Reading level: » Easy~ Moderater Challenging

Also search in: ~World Almanacr Encyclopedia

Limit results to articles in lexile range: | to|

Search |

Home Page | Current Events | Spotlight of the Month | World Almanac | Encyclopedia
Dictionary | Thesaurus | Help | Tips | Cite | Workbooks | Tutorial | Research Topics

Educator's Resources | Privacy | Accessibility | License | Contact

Copyright © 2006 ProQuest Information
and Learning Company. All rights reserved.

From :Pro(:ug_s_i



Search by key word

. u n \_—
I h I n kf I n It y FREE educational resources for everyone  myThinkfinity =~ verize

brought to you by the Verizon Foundation

Tha Venzon Foundation | About Thinkfouty = Literacy Hetwork  Contact Us Free Thinkfinity Training

search for |eSS »n plans,
el fnal_EE interactive 5 & more...
i Cast Your Vote in YLI's Mock .
Election |

Learn motre about our FREE The 2008 Wlock Election, hosted by The ﬁ (7] (7]
tools and educational Youth Leadership Irtiatrve at the Y L l ISearch & ;I IAII ;I

Urrversity of Virginia Center for Politics,

HESHIEES. 15 the largest secure, student-only, onlive ',:u::t',-":ﬂi:.?ﬂm'.'!: ,“: :
rnck election in the nation! Mark your — www.youthleadership.nel | Search A =l
|'- " a
=]

| . calendars now and plan to join VLI and
e — millions of students nationwide October Search Al
20-30, 2002 read

mare ==

educator student parent ‘ afterschool

http://thinkfinity.org/




Search MarcoPolo Basic Search

: ; Advanced Search
Find Quality Internet Content for Your Classroom! R TR

Browse Keywords

The MarcoPolo Search Engine provides
access to all of the educational resources
created by the MarcoPolo Partners plus
Partner reviewed materials. See the rags
for more information.

Search for: ||::I|:|ud5 using |AIIWDrds j

Boolean Phrase Help

Search Clear Form |

Limit Subjects to:

I~ Foreign

- Arts I~ Economics L
anguage

~ Language

~ All| I~ Geography I~ Mathematics

Arts
I Philosophy & |~ giience |- Social Studies
Religion
Limit Grade Level to:
‘7 ANl K-2 r 3-5 r 6-8 'ri9-12

Limit Results to: |All Resources |

http://www.marcopolosearch.org/MPSearch/Basic Search.asp




Website Suggestions on the HIAT webpage
e, Montgomery County Public Schools |

ROCKVILLE, MARYLAND _ Index of Topics

" FORPARENTS FORSTUDENTS FORSTAFF

nggem HIAT — Wehsites

Accessible Technology Websites to Support All Students

HIAT Home

» Most Requested Educational websites are a critical ingredient of universal design for learning, MCPS is a
: subscriber to many fee-based educational websites, See the list of MCPS online
¥ Draft:Builder Teacher
Quick Guide [(PDF)

> Written Productivity

Profile (PDF) .

subscriptions.

= HIAT training Wehsites that support Sites to find e-text to audio and e-book

> Online tutorials teaching across a use with text reader downloads and online

> Tech quick guides variety of subjects, Go software. Find entire books in a variety of

B ok s partcipants to curriculum sites bool:s, poems, folktales, forrnats. Go to e-
Go to e-text sites books sites

SUFYEYS

About digita text. Math Reading and Writing

=

= Classroom strategies _ _ ) ) : '

> Ppurchasing resources Find graphics to suppart Websites with teaching Sites to suppart

> Printable tools building the creation of resources and online teaching of reading and

S ok thie N AT webiita universally designed Qames an-:l_tut-:unals. Go writing with teacher
teaching materials, Go to math sites tonls and anline

» Tech Quick Cuides: to graphics sites activities for kids, Go to

2 reading and writing
sites

» Educational Websites

* Curriculum

> E-text Science and Social : : : e
bl Stitlin. Search Website Descriptions




Copy and Pasting Text from a
Website in to MS Word

Click at the beginning of where you want to
copy the text

Hold down the shift key

Scroll down and click at the end of the text.
Control C = copy

Open MS Word

Control V = paste

Use Control A = Select all, to format text



Autosummarizing Expository
(non-fiction) Text



Use Autosummarize in MS
Word to Modify Text

*Open MS Word. Go to “Tools” > AutoSummarize to
modify the amount of any digitized text.

*You can modify any document that you have
typed or scanned into a word processor, or any
electronic text from a website.

*For example, if you find information on the web,
but it iIs too much text for your students, you
can use autosummarize to reduce the
percentage of text. This works best with
expository text.



AutoSummarize

2|

Word has examined the document and picked the sentences most relevant

to the main theme.

Type of summary
— Highlight key paints Insert an executive
— =——| summary or abstract
—_— =—| at the top of th
— ——| documen t
i— | Create anew Hide everything but
= |} documen t and put the =—| the summary without
summary there leaving the original
documen t

Length of summary

Percent of original:

IZS% VI

7Iwordsin 7

sentences

289 words in 24 sentences

¥ Update document statistics {dick Properties on the File men)

o |

Cancel |

How to AutoSummarize:
«Select the text you want to
modify by highlighting it and
copying it (CTRL C) and then
pasting it (CTRL V) into an
MS Word document

Click on “Tools”

Click on “AutoSummarize
*You will get a pop up window.
Note that you can adjust the
percentage of the length of the
summary. Start with 25% and
click OK.



Use the arrows to adjust the length of the text
upward or downward. The highlighted ayeas
show you the autosummarized text.

 AutoSummarize

: 4| 4 3
Forest Biomes 7 ‘ 45% ‘5'05‘"'

About 420 million years ago, during the Silurian Period, ancient plants and
arthropods began to occupy the land. Over the millions of years that followed.
these land colonizers developed and adapted to their new habitat. The first
forests were dominated by giant horsetails, club mosses, and ferns that stood up
to 40 feet tall.

Life on Earth continued to evolve, and in the late Paleozoic, gymnosperms
appeared. By the Triassic Period (245-208 mya), gymnosperms dominated the
Earih’s forests. In the Cretaceous Perniod (144-65m mya), the first flowering
plants (angiosperms) appeared. They evolved together with insects, birds, and
mammals and radiated rapidly, dominating the landscape by the end of the
~erod The landscape changed again during the Pleistocene Ice Ages—the
surface of the planet that had been dominated by tropical forests for millions of
years changed, and temperate forests spread in the Northern Hemisphere.

Today, forests occupy approximately one-third of Earth’s land area, account for
over two-thirds of the leaf area of land plants, and contain about 70% of carbon
present in living things. They have been held in reverence in folklore and
worshipped in ancient religions. However, forests are becoming major casualties
of civilization as human populations have increased over the past several
thousand years, bringing deforestation, pollution, and industrial usage problems
to this important biome.



Once you have this at the level you want, click on close.
Go back to Tools > AutoSummarize and select the

option “Create a new document and put the summary
there.” Your % of text is automatically condensed Into a
new fl |e AutoSummarize 2] x|

Word has examined the document and picked the sentences most relevant
to the main theme,

Type of summary

Highlight key paints Insert an executive

summary or abstract

at the top of the
document

Hide everything but
the summary without

Create a new
document and put the

summary there leaving the original
document
Forest Biomes el lnE L
Percent of original: 25%% -
About 420 million years ago, during the Silurian Period, ancient plants ant  Summary: 79 words in 7 sentences

arthropods began to occupy the land. By the Triassic Period (245-208 py ~ ©On9neldocument: 288 words n 24 sentences
gymnosperms dominated the Earth’s forests. The landscape changed age
during the Pleistocene Ice Ages—the surface of the planet that had been ¥ Update document statistics (click Properties an the File menu)
dominated by tropical forests for millions of years changed, and temperate o |
forests spread in the Northern Hemisphere_r =

Cancel

Today, forests occupy approximately one-third of Earth’s land area, account for
over two-thirds of the leaf area of land plants, and contain about 70% of carbon
present in living things.



Summarizing information they
have read

Using Labels on MS word as notecards



Use “Labels” to make note
cards

¥ Document3 - Microszoft Word

File Edit ‘jew Insert Format | Tools i Table ‘window Documents To Go Help  Adobe PDF Acrobat Comments

lJ ﬁ H L&Hf‘ L&|‘? '5' speling and Grammar... F7 l% ._j' =] E 4;|@ T 114% .

 Final Showing Markup - Word Count... =, ! : Mormal » Times Mew Roman -

La} Track Changes  Chrl4+Shift+E
|. - L D S
| Letters and Maiings b Mail Merge. . _
Qpkions. .. Show Mail Merge Toolbar
| Ernwelopes and Labels. .,
Letter Wizard, ..

Tools > Letters and mailings > envelopes and labels > Labels > Options >2 x 4
shipping labels > New Document

[




Click on the
Labels Tab

Envelopes and Labels

Envelopes Labels

Address: Ll - I Usereturn address

Prink

| .

Mew Document

Cancel

Cipkions., ..

=l

E-postage Properties. ..

[ Delivery point bar code 1 abel
—Print fvery standard, 8163
" Full page of the same label Shipping
" Single label
Ruo: |1 5‘ Calurmn: |1 5‘ [ ]

Before prinking, insert labels in wour printet's manual Feeder.,

Click on New

ocument

Go to
Options to
choose a
different
size label.



2 x 4 shipping labels can be
used as notecards

Type notes on each
section.

Print on card stock
and cut them into
notecards

Sort the notecards to
organize writing topics



Knightcite

http://www.calvin.edu/library/knightcite




[The Internet iIs...

A rich source of information and
supports

A tool you can use at home to support
your student learners.



